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Introduction

Overview
The Motion Lab Systems C3dExport program is an application which allows you to
save information the contents of the VICON Clinical Manager (VCM) database to a
C3D file that uses the database information.  Thus, for the first time, it is possible to
have a C3D file that contains not only the kinematic and kinetic data but also the
database entries that are required to analyze the information.

Naturally, the C3dExport program allows you to read this information back from the
C3D file and recreates the original VCM database entry at any time.

You will find the C3dExport program useful when you need to:

•  Backup and Archive a patient file.  There is no danger of losing the
database information because it’s always present in the C3D file.

•  Exchanging Data with another site.  Just use C3dExport and attach the
database information.  Then send one file – the C3D file.  This saves
time over using the cumbersome VCM database export method which
is unreliable and expects the users to exchange seventeen files just to
transfer or backup one patient!

•  Build a central database for VCM users.  There’s no need to worry
about the problems of maintaining a multi-user VCM database.  Each
user can have their own database and use C3dExport to attach their
database records to the data.  These files can then be stored on a central
database by reading the database values directly from the C3D file
using C3dExport.

•  Viewing the Database Contents.  C3dExport allows you to view the
contents of the VCM database in a normal, human-readable, manner.

The C3dExport program is a 32-bit application, written to run on Microsoft
Windows 95 and Windows NT systems.  It is supplied with a full installation setup
and removal program.

C3dExport uses ODBC to access the VCM database so you must have installed
Microsoft ODBC on your computer in order to use the program.  Please contact
Motion Lab Systems technical support if you have problems obtaining ODBC or
setting it up.  It is very likely that ODBC will already be setup on your system as it is
supplied with many common applications from Microsoft.
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Installation
You can use the Windows Add/Remove Programs option in Control Panel to install
the program from a floppy disk.  This will load the program on your system and
configure the system to run the program.  Simply copying the program files from one
system to another system will not work reliably as the installation program uses the
registry on your computer to store information.  Simply copying the files will not
install this information in the registry.

During installation the setup program will prompt you to enter a license number.
Enter the number on your software license (in the form 0000-0000-0000-0000),
together with the User Name and User Organization information.

Please check that you are entering the information exactly as it appears on the
software license as even small spelling or punctuation errors will cause the software
to fail to register you as an authorized user.  If this happens then please review the
software license details supplied and contact technical support at Motion Lab
Systems for

You must have installed Microsoft
ODBC on your computer in order to
use the C3dExport program.

If you accept the default options during installation, then you will have created a
short-cut in the Gait Lab menu group called MLS – C3dExport together with a
desktop short-cut.

C3dExport shows the name of the registered user in the About dialog box accessed
from the Help drop-down menu.  This can be opened by choosing the About
command (Help menu) or by clicking on the button on the Toolbar.  This dialog box
will also show you the Version Number of the program.

Updates to the program are available from Motion Lab Systems or, over the Internet
directly from the web site at www.EMGsRus.com   

If you need to transfer data to another location that does not have a copy of the
C3dExport program then they should obtain an evaluation copy from our web site or
by contacting us directly.  This copy can be used in the evaluation mode and will
transfer up to 50 files.  In this way you can verify that the planned data exchange will
work in the way that you anticipate without having to purchase a copy immediately.

Licensing
Unlike many programs that limit the user to operating (legally at least) on a single
computer, the C3dExport program is licensed to be operated at any computer that is
described by the User Name and User Organization entries.  This is called a “Site
License” and permits a registered user to install the program on any computer at a
single location.

This is designed to make the program easy to install and use.  Please contact Motion
Lab Systems if you are unclear about any particular situation.  In general, if you are
the user and location described in the “About box” then you are a licensed user.

Evaluation mode
Unlike many programs that require you to purchase the program before you can find
out if it really works the way the sales literature describes, the C3dExport program
can run in an evaluation mode so that you can try out the product before you
purchase a copy.  Anyone can request an evaluation copy of the program from
Motion Lab Systems or download a copy via the Internet.
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In the evaluation mode, the application allows you to carry out 50 operations.  The
two operations that are counted are the transfer of data from the database to the C3D
file (Extract) and the transfer of data from the C3D file to the database (Import).

You can continue to use the program to view the contents of any VCM database even
if you chose not to purchase a registered copy – however we are unable to provide
any support to unregistered users after the initial evaluation period has expired.

You can purchase a registration key and manual from:

Motion Lab Systems, Inc.
4326 Pine Park Drive,
Baton Rouge, LA  70809-2397  USA
Voice: +1 (504) 928-GAIT (4248)
Fax: +1 (504) 928 0261

Email: sales@EMGsRus.com
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Commonly Used Terms

This section explains some of the terms used in the documentation and also the
different input and output files that are used by C3dExport.

Controls
These are the User Interface items that are found in Windows 95.  These controls
work much the same way in most applications.  The most commonly used controls
are Edit boxes, List boxes, Radio buttons, Check boxes, File Open dialog box etc.

C3D File
A file format developed for the NIH by ADTECH for the requirements of the
Biomechanics environment.  C3D stands for Coordinate 3d Data.  The format is
complex but very versatile and allows kinematic and kinetic data to be stored in a
single file together with all the parameters necessary to describe the data collection
environment.

Data Sources
A “data source” is simply a term that is used to refer to the general method that a
program (in this case C3dExport) uses to obtain access to data.  In this case the Data
Source is the Paradox database that is used by VCM .

The purpose of a data source is to gather all of the technical information needed to
access the data—the driver name, network address, network software, and so on—
into a single place and hide it from you, the user.  You should be able to look at a list
that includes Patient Name, Patient ID, and Trial Number, choose Patient ID from
the list, and have the C3dExport program connect to the list of Patient ID records, all
without knowing where the data resides.

When you set up the Microsoft 32-bit Open Database Connectivity (ODBC) service
you will be shown two types of data sources: machine data sources and file data
sources. Although both contain similar information about the source of the data, they
differ in the way this information is stored.  C3dExport program uses Machine Data
Sources and NOT File Data Sources.

Open Database Connectivity (ODBC)
ODBC is a service that lets any Windows application access any database using a
single SQL like language.  SQL means Structured Query Language which provides a
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standard way to read and write information in any database.  Under this system any
program that knows how to talk to ODBC can talk to the database provided that the
system contains the appropriate ODBC driver for that database.  The C3dExport
database mode uses a Paradox ODBC driver to access the VCM database.

VICON Clinical Manager (VCM)
Oxford Metrics Ltd. VICON Clinical Manager (VCM) is a Windows 3.1 program
that produces clinical analysis reports.  It allows the user to analyze gait data with
standard marker placement.  It has a Paradox database that holds the biomechanical
variables and also the information about the subject.  Updates and support for VCM
are available from the programs manufacturer, Oxford Metrics Ltd.

VCM database
The VICON Clinical Manager program uses a number of databases to store
information related to the clinical data that it analyses.  These databases are
collectively known as the VCM database.  The databases are written in a format
called Paradox.
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Using the Program

The User Interface
When the Motion Lab Systems C3dExport program is started, the application
searches for an ODBC data source to open.  If there is no data source found, or a data
source that has not been set up yet, the application will prompt you to choose a data
source from a list or to create a new data source.  You must have an ODBC link to
the VCM database in order to use C3dExport – if you have any problems setting up
or configuring ODBC then see your system manager or call Motion Lab Systems for
support.

C3dExport (like all MLS programs) is
a 32-bit Windows 95/NT application
and will respond to all the normal
commands to position and control the
display.  It can be represented on the
screen in one of the three ways: full
screen (maximized), as an application
icon (minimized), or within a window
(restored).

Once an ODBC data source has been located C3dExport opens the VICON Clinical
Manager database and displays the database to you in a hierarchical manner.  The
application remembers how it was set up the last time it was used – whenever you
start the program the size of the main window and the position of the Toolbar will be
the same they were when you last used the program.

The name of the Data Source will be displayed in the top left corner of the
application (after the name of the organization and program name). At this point all
the commands that you will need are on the short-cut bar at the top of the program
window
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The Application Workspace
The C3dExport program is very easy to use.  When you start it up you’ll see the
main application window with a simple tool bar at the top of the window and a status
bar at the bottom of the window.  You can turn these off if you want to but you’ll
probably find it more convenient to leave them visible.

You can sort and display the Subject
level by Subject Name, Subject Number
or Physician Name.

The application window is split into two panes.  The contents of the VCM database
is displayed in a tree form on the left side.  The hierarchy is shown below, and
follows the normal VCM conventions.  Each level shown has information separated
by colons.  All lower levels are sorted and displayed as shown below.  As you
browse through the VCM databases displayed in the left (tree) pane, you will find
that the contents of each database are displayed in the right pane as a list of data
values, together with the appropriate units – such as mm., and degrees, etc.

See the VICON Clinical Manager
manual for reference information
about the VCM database.

The programs ability to display the VCM database contents in plain English make
this a very useful program for any VCM user or researcher who stores large amounts
of information in the VCM database.

VCM actually maintains a number of separate databases which are linked together to
form two independent databases.  One database tracks physicians while the second
database maintains the clinical information about the subjects and the trial records.
The different levels of the VCM Clinical database are:

Subject

This level contains the Subject Name, Subject Number and Physician Name on the
left while the linked physician information for the subject is displayed on the right
side.  The order in which these items are displayed depends on the sorting order
which can be selected from the view menu at any time.  You do not have to close the
program down and edit an INI file by hand in order to view a new sort order.  The
sort display is as shown below:

Sorted By Item Order
Subject Name Subject Name : Subject Number : Physician Name

Subject Number Subject Number : Subject Name : Physician Name

Physician Name Physician Name : Subject Name : Subject Number
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Session

This level contains the Session Number, Session Date on the left while the pane on
the right side displays information related to the specific VCM session that is
highlighted.  Note that the information contains measurement information that is
stored in the database.  All the information here is displayed in human readable form
so that anyone can browse through a VCM database and examine the contents.

Trial
For security the value of the Password
field is always shown as “Encrypted”.
This field contains the user account
password when the clinical C3D data
originates on a VAX system using
PathWorks.  C3dExport does not
encrypt or change the password in any
way.  All VCM releases prior to 1.20
stored the VAX account password as
plain text.

Although the value of the field is not
shown it is still stored in its original
format in the C3D parameters and will
be restored into the database if
required.

This level displays the Trial Number and the Trial Type in the left hand pane.  The
Trial Type is a database entry that tells you the kind of data that was collected in the
trial.  Trials can be Static Trial, Dynamic Gait Data, and Dynamic Gait Data with
EMG.  Note that the value of the password is not displayed.

The view on the right side consists of the fields in the database for the item selected
in the left pane.  There are two columns, Field, which is the name of the field in the
database and Value, which is the value of the field.  If the value column is empty, it
indicates that the database field did not have a value entered into it.  You can choose
to see only those fields which have a value associated with it by selecting “Hide
empty fields” in the view menu.
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Report

This level contains the Report Number and the Report File Name (the file that VCM
uses to control the formatting of the displayed the data in a Report).  VCM allows a
trial to have several reports associated with it and so you may see a number of report
records attached to the trial data.

Using the C3dExport program
C3dExport will import and recreate a
VCM database from any C3D file that
contains the correct parameters.  It is
not necessary that the parameters come
from a VCM database – only that they
exist.  Data created by any application
would be quite acceptable if the values
are stored in a compatible manner.

This is a very easy program to use as you generally only want to do one of two
things when you run the program – either:
1. Export the VCM database records to a C3D file for archive or backup purposes.
2. Restore an entry to a VCM database using parameter data stored in a C3D file.
These are both very simple operations that can be accomplished in seconds!

Exporting the VCM database
Once the C3dExport program has started up and connected to the VCM database you
will be shown the contents of the database.  Browse through the database using the
view on the left side of the C3dExport to locate the subject and trial that you want to
export.  Highlight the trial using the mouse and then use either the extract option for
the File Menu or double right click to display the Export / Import menu.  When you
select Export the VCM database entries will be copied from the VCM database and
inserted into the parameter header of the C3D file specified in the database record.

If you are archiving the data then you may wish to delete the record from the VCM
database at this time using the delete option.

Importing to the VCM database
If you are restoring information to the VCM database from a C3D file then all you
need to do is start the C3dExport program – it will connect to the VCM database that
will hold new records.  Then use the File menu and select Import and use the browse
menu that appears to locate the C3D file that contains the database information.
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File menu

The file menu contains all the commands that are useful in selecting the database and
performing the data transfers.  You can also set the default location of the VCM data
files from here.

ODBC Data Source
This command allows you to choose a different VCM database from the one that is
currently open.  The name of the current VCM database is displayed on the title bar
at the top of the C3dExport application window – this is the name that all ODBC
references use when they need to read or write to this specific database.

If you select ODBC Data Source from the File Menu then the C3dExport application
will display the name of the current VCM database that is being used (this is the
“data source”) and will ask you if you want to choose a new data source. If you want
to keep the existing VCM database connection then just answer NO to the question.
Answer YES only if you want to select a new VCM database or set up an ODBC link
to a new database.
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Extract

The Extract toolbar button

The Extract command to copy the VCM database entry into the C3D file can be
issued by double clicking the right mouse button or from the toolbar button.

The command is used to extract the data in the VCM database and transfer this data
to the C3D file.  This command is enabled only when the selected item in the Tree is
a trial.  The data is transferred to the file name found in the Trial Data File.

The application transfers all the fields present in the Patient, Physician, Session, Trial
and Report tables to Groups in the C3D file with the same name.  If a group with this
name exists in the C3D file, it will be overwritten.  The names of the parameters in
the Groups are the same as the names of the fields in the tables.

It is possible that for a given trial there could be more than one report.  In that case
the Report dialog box will open and you can choose the report to extract.

This dialog box contains a drop down box which lists the reports associated with the
trial.  Choose the one you want to extract and click OK.
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File Location
This command is used to specify the location of the C3D file, if the file location
found in the Trial data file field is a relative path.  You can the enter the initial part
of the path which will be prefixed to the relative path to form the complete path.

This command opens the C3D File Location dialog box, which can be used to
specify the path.

Import

The C3D data Import toolbar

The import command can be issued by using the toolbar, selecting the Import
function on the File menu or by double right clicking the mouse anywhere in the
database tree display.

This command allows you to import the data from the C3D file to the VCM
database.  The C3D files should contain the parameters which were exported from
the database.

The application reads the parameters that have previously been saved in the C3D file
by C3dExport and creates the necessary entries in the current VCM database.  If a
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parameter is not found, its value in the database will be NULL (corresponding to not
entering a value).  If a record is present, but there are some values that are different
the application asks you if you want to update the record.   If an identical record is
already present no action is taken.

The actions taken in an Import operation will be reported to you in the Import Log
dialog box.  The import of data can be a lengthy operation and you can see its
progress on the left side of the Status bar.

Exit
This command causes any the application to close the data source and exit.

Edit menu
This menu contains only one command which allows you the delete the selected
record from the VCM database.  Use this command with caution because unless you
have a backup copy of the database record (or have already exported the database to
a C3D file) there is no way to undo this operation.
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Delete Record

The Delete Record tool button

The Delete Record function is only available from the Edit menu or the toolbar
button.

This command allows you the delete the selected record and all its sub-records.  The
application prompts before actually deleting the record(s).  This operation cannot be
undone except by importing the data back into the database from a C3D file.

View menu
This menu contains all the commands for controlling the way you see the application
workspace.  You can show or hide the tool bar and status bar, sort the tree items and
also hide the fields with NULL values.
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Toolbar
This command can be used  to display and hide the Toolbar, which includes buttons
for some of the most common commands in C3dExport.

Toolbar Button Menu Command
Extract command (File menu)
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Import command (File menu)

Delete Record  command (Edit menu)
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About command (Help menu)

A check mark appears next to the menu item when the Toolbar is displayed.  The
toolbar is displayed across the top of the application window, below the menu bar.
The toolbar provides quick mouse access to many tools used in C3dExport.

Status Bar
This command can be used to display and hide the Status Bar, which describes the
action to be executed by the selected menu item or depressed toolbar button, and
shows you if the application is registered. A check mark appears next to the menu
item when the Status Bar is displayed.

The status bar is displayed at the bottom of the C3dExport window The left area of
the status bar describes actions of menu items as you use the arrow keys to navigate
through menus.  This area similarly shows messages that describe the actions of
toolbar buttons as you depress them, before releasing them.  If after viewing the
description of the toolbar button command you wish not to execute the command,
then release the mouse button while the pointer is off the toolbar button.  This area is
also used to show you the status of a lengthy operation such as the import operation.
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The right area of the status bar is to show the registration state.  If  the application is
not registered, it will show you the number of operations that is allowed.
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Sort By – Subject Name
This command is used to sort the items is the tree by the name of the subject.  The
order of sorting is Subject Name : Subject Number : Physician Name.  A tick mark
appears next to this item is this is the sort order.

Sort By – Subject Number
This command is used to sort the items is the tree by the ID number of the subject.
The order of sorting is Subject Number : Subject Name : Physician Name.  A tick
mark appears next to this item is this is the sort order.
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Sort By – Physician Name
This command is used to sort the items is the tree by the name of the subject.  The
order  of sorting is Physician Name : Subject Name : Subject Number.  A tick mark
appears next to this item is this is the sort order.

Hide Empty Fields
This command can be used to Show or Hide all the empty fields on the right side of
the application workspace.  If this command is selected, a tick mark appears next to
it and all the empty fields are hidden.

Help menu

This menu contains commands useful to access the built in Help information about
the C3dExport program, and also allows you to register the program by entering a 16
digit registration code that you can purchase from Motion Lab Systems.  In addition,
if you have an Internet connection on your computer, you can run your Internet
browser and contact the Motion Lab Systems web site to check for additional
information and updates to this program.  Our web site is http://www.emgsrus.com
and always contains the latest update of this program.  You can download and install
any Version 1.xx update without charge.

Help Topics
This command gives an index of the help topics that are available for the application.
It is possible to search for a topic of interest.  Help is available by highlighting a
menu item and then clicking the F1 key.  Help can also be sought by clicking the
Shift-F1 keys.  This transforms the cursor into a help cursor and the user can click on
the item of interest to see the help topic associated with it.
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Register
This command enables you to register this application if you have previously
downloaded an evaluation copy and subsequently purchased a registration key for
the program.  This command opens the Register dialog box.  Motion Lab Systems,
Inc., registration keys consist of a User Name, Organization Name and a sixteen digit
serial number.  You must enter this information correctly before the application will
perform more than 50 operations.

Register dialog box
This dialog box can be used to register the C3dExport program so that you can use it
to export and import an unlimited number of database entries.  You can enter you
name and organization and the 16 digit code given to you by Motion Lab Systems.

The registration box has the following fields:

•  User Name
Enter the name of the User – this is usually filled in when you install the
program and will default to the name of the user that is logged into the
computer.  When you register the program you will be able to select your own
User Name which may be something generic like “Gait Analysis Lab.”

•  User Org
Enter the Organization of the user – this is usually filled in when you install the
program and will default to the name of the organization that installed the
operating system on your computer.  When you register the program you will be
able to select your own User Organization which must describe the location that
has purchased the registration.

•  Reg. Num.
Enter the 16 digit code provided to you by Motion Lab Systems.  If C3dExport
is already registered, Licensed Copy will appear in this field.

•  OK
Click on this button to validate the changes you have made and close the dialog
box.  The modifications you made will be written to the registry and the code
will be checked.
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•  Cancel
Click on this button to ignore all you changes and close the dialog box.

MLS Home Page
If you have an Internet connection and use the World Wide Web then you can launch
your Internet Web browser directly from this item and visit the Motion Lab Systems
Home Page on the Internet.

You can check here for new updates to this application, download evaluation copies
of other Motion Lab Systems software products, and view technical and sales
information about the various hardware products available from Motion Lab
Systems.

You can also contact Technical Support and Sales directly from this web page.

About C3dExport
This opens a display box that provides some basic information about the C3dExport
application.

This dialog box shows you the following information:

•  The Name of the Application with the Application Icon and the logo of Motion
Lab Systems.

•  The Version Number of the Application.

•  The Name and Organization of the user.

•  Whether you are using an Evaluation Copy or a Registered Copy of the
Application.

General Information
This section lists some general information about the Application.

Title Bar
The title bar is located along the top of a window.  It contains the name of the
application and the name of the data source.
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To move the window, drag the title bar.  Note: You can also move dialog boxes by
dragging their title bars.

A title bar contains the following elements:

•  Application Control-menu button

•  Maximize button

•  Minimize button

•  Restore button

•  Name of the application

•  Name of the data source

Scroll Bars
Displayed at the right and bottom edges of the document window, if the size of the
window is smaller than what it should be to display the contents of the window.  The
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scroll boxes inside the scroll bars indicate your vertical and horizontal location in the
document.  You can use the mouse to scroll to other parts of the document.

Size command (System menu)

This command can be used to display a four-headed arrow so you can size the active
window with the arrow keys.

After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to
move the pointer to the border you want to move.

2. Press a DIRECTION key to move the border.

3. Press ENTER when the window is the size you want.

Note:  This command is unavailable if you maximize the window.

Shortcut

Mouse: Drag the size bars at the corners or edges of the window.

Move command (Control menu)

This command can be used to display a four-headed arrow so you can move the
active window or dialog box with the arrow keys.
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Note:  This command is unavailable if you maximize the window.

Shortcut

Keys: CTRL+F7

Minimize command (application Control menu)
This command can be used to reduce the C3dExport window to an icon.

Shortcut

Mouse: Click the minimize icon

 on the title bar.

Keys: ALT+F9

Maximize command (System menu)
This command can be used to enlarge the active window to fill the available space.
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Shortcut

Mouse: Click the maximize icon

 on the title bar; or double-
click the title bar.

Keys: CTRL+F10 enlarges a document window.

Close command (Control menus)
This command can be used to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:  If you have multiple windows open for a single file, the Close command on
the file Control menu closes only one window at a time.  You can close all windows
at once with the Close command on the File menu.

Shortcuts

Keys: CTRL+F4 closes a file window

ALT+F4 closes the application window or dialog box

Restore command (Control menu)
This command can be used to return the active window to its size and position before
you chose the Maximize or Minimize command.

Shortcut
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Mouse: Click the maximize icon

 on the title bar; or double-
click the title bar.
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Data Sources

This chapter deals with choosing a Data Source and creating new Data Sources to
enable you to directly access the information contained in the VCM database.

Setting up the data source can be a little tricky if you are not familiar with the
Microsoft Open Database Connectivity (ODBC) feature.  However, a little effort to
get this working will pay off as you will then be able to browse through the VCM
database and extract the necessary information into the C3D files without having to
know what any of the files are called.

These instructions assume that you are using the current 32-bit ODBC application
available directly from Microsoft – if your ODBC displays do not look like the ones
shown you may need to obtain an update from Microsoft.  All the operations
described in this chapter are accessible through the 32-bit ODBC option in the
Windows 95 Control Panel.

Selecting an Existing Data Source
The ODBC Data Source command should be chosen from the File menu.
However, note that a data source will have to be created before it can be selected.
You may create as many Data Sources as you have VCM databases and then switch
between them instantly by using this command.

The Select Data Source dialog box opens.  This box has two tabs.  Choose the
Machine Data Source tab.  This tab has a multiple column list box which lists the
following,

•  Names of the Data Source.

•  Type of data source, which can be User or System.

•  Description of Data Source.
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Choose the Data Source in the list box by clicking on it and then click the OK
button.  C3dExport will now use this Data Source and display the contents of the
selected database.

Creating a new Data Source
The ODBC Data Source command should be chosen from the File menu.

If there is no existing data source or the data source is incorrect then you may receive
an error message – if so select YES to select a new data source.  The Select Data
Source dialog box opens.  This box has two tabs.  Choose the Machine Data
Source tab.  This tab has a multiple column list box as shown below and which lists
the following,

•  Names of the Data Source.

•  Type of data source, which can be User or System.

•  Description of Data Source.

Click on the New button to create a new Data Source.
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This opens a dialog box that contains two radio buttons User Data Source and
System Data Source.

•  Choosing User Data Source will mean that the Data Source created will be
available only to the user who creates it.

•  Choosing System Data Source means that the Data Source will be available to
all users on the machine.

After choosing one of the above, click on the Next button.  Choose System Data
Source unless you have a good reason for selecting User Data Source.  In most cases
it will not make any difference which option you select at this point unless several
different people use your computer.

This opens the Create New Data Source page  which will give you a list of drivers
present.  Choose the Microsoft Paradox Driver (*.db) as the VCM database is a
Paradox Database.  Click on the Next button.
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This opens a page that displays a little information about the choices.  Click on the
Finish button to finish the process.

This opens the ODBC Paradox Setup dialog box in which you need to enter some
information in the following fields,

•  Enter the Name you want the Data Source to have in the Data Source Name
box.

•  Enter the Description for the Data Source in the Description box.  This step is
optional but useful if you are using several different VCM databases as you can
enter a long description.

•  Uncheck the Use Current Directory box otherwise this will usually point to
the wrong directory – you need to specify the directory that stores the VCM
database.

•  Click on the Select Directory button.  This opens a Select Directory dialog
box, which you can use to browse the directory structure of the machine.
Choose the directory in which the VCM database files reside, and click OK.

•  Click OK in the ODBC Paradox Setup dialog box.  This takes you back to the
Select Data Source dialog box in where you will see that the newly created
Data Source is listed.  Choose the Data Source that you have just created and
click OK.  C3dExport will now open the VCM database and display the
database contents.

If you do not see the correct database entries you may have entered some
information incorrectly and will need to either delete the entry or modify it using the
32-bit ODBC option in the Windows 95 control Panel.
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